SI-3050
PSI/SI Generator
User Manual
VERSION 2.1

Rev A
Scopus Manual Part No. 100793
Disclaimer

Harmonic reserves the right to alter the equipment specifications and descriptions in this publication without prior notice. No part of this publication shall be deemed to be part of any contract or warranty unless specifically incorporated by reference into such contract or warranty. The information contained herein is merely descriptive in nature, and does not constitute a binding offer for sale of the product described herein. Harmonic assumes no responsibility or liability arising from the use of the products described herein, except as expressly agreed to in writing by Harmonic. The use and purchase of this product do not convey a license under any patent rights, copyrights, trademark rights, or any intellectual property rights of Harmonic. Nothing hereunder constitutes a representation or warranty that using any products in the manner described herein will not infringe any patents of third parties.

Trademark Acknowledgments

Harmonic and all Harmonic product names are trademarks of Harmonic Inc. All other trademarks are the property of their respective owners.
# TABLE OF CONTENT

## Chapter 1. Overview ...................................................... 1-10

1.1. Technological Edge......................................................... 1-10
1.2. Highlights and Benefits ................................................... 1-11
1.3. Applications .................................................................. 1-13
1.3.1. PSI/SI Generator Integration in DVB Application ................. 1-13
1.3.2. Standard PSI/SI Application ............................................ 1-14
1.3.3. Distributed PSI/SI Application ......................................... 1-14
1.4. Functional Description .................................................... 1-16
1.4.1. PSI/SI Database ............................................................ 1-16
1.4.2. Data Carousel ............................................................. 1-16
1.4.3. PSI/SI Generator Remote Client ....................................... 1-17
1.5. PSI/SI Tables ................................................................ 1-18
1.5.1. MPEG-2 PSI Tables Description ........................................ 1-18
1.5.2. DVB – SI Tables Description ............................................ 1-19
1.6. Platform Specifications .................................................... 1-21

## Chapter 2. Installation .................................................. 2-22

## Chapter 3. PSI/SI Management Window ....................... 3-26

3.1. General ........................................................................ 3-26
3.2. Menu Bar ................................................................. 3-27
3.2.1. Menu Bar Structure ..................................................... 3-27
3.2.2. Connect to Database .................................................... 3-31
3.2.3. Disconnect from Database ............................................. 3-32
3.2.4. Create New Database .................................................. 3-33
3.2.5. Backup Database Dialog ............................................. 3-34
3.2.6. Restore Dialog ........................................................... 3-35
3.2.7. Send Tables Dialog ..................................................... 3-36
3.2.8. Receive Tables Dialog ............................................... 3-37
3.2.9. PSI/SI Tables Rate Measurements Dialog .......................... 3-39
3.2.10. Profiles Dialog .......................................................... 3-40
3.2.11. Log Dialog ............................................................... 3-41
3.2.12. Stream Configuration ................................................ 3-42
3.2.13. PID Contents Management ......................................... 3-46
3.3. Tool Bar ....................................................................... 3-47
3.4. Main Display View ....................................................... 3-49
3.4.1. Exporting All DVB Network Information to XML ............... 3-51
3.4.2. Adding Items to the PSI/SI Management Tree .................. 3-51
3.4.3. Changing Item ID on the PSI/SI Management Tree ............ 3-52
3.4.4. Removing Items from the PSI/SI Management Tree .......... 3-52
3.4.5. Copying / Cutting Items from the PSI/SI Management Tree . 3-53
3.4.6. Pasting Items on the PSI/SI Management Tree ................ 3-53
3.4.7. Drag and drop support ................................................ 3-53
3.4.8. Disabling Items .......................................................... 3-54
3.4.9. Importing Events ................................................. 3-55
3.5. Detailed Display View ............................................... 3-56
3.5.1. Item Name Section ............................................... 3-57
3.5.2. Properties Section ................................................ 3-57
3.5.3. Advanced Table Settings ........................................ 3-60
3.5.4. Descriptors List Section ........................................... 3-61
3.5.5. Descriptors Management Section .............................. 3-63
3.5.6. Proprietary Descriptors ......................................... 3-64

Chapter 4. Bouquets Management Window ................... 4-65
4.1. General .................................................................. 4-65
4.2. Main Display View .................................................. 4-66
4.3. Detailed Display View ............................................... 4-67
4.3.1. Item Name Section ............................................... 4-67
4.3.2. Properties Section ................................................ 4-67
4.3.3. Descriptors List Section ........................................... 4-67
4.3.4. Descriptor Management Section .............................. 4-68

Chapter 5. Event Management (EPG) Window ............ 5-69
5.1. General .............................................................. 5-69
5.2. Event Management Menu Bar ................................. 5-70
5.2.1. Menu Structure .................................................. 5-71
5.2.2. Finding Events ................................................... 5-71
5.3. Tool Bar .............................................................. 5-77
5.4. Main Display View .................................................. 5-77
5.4.1. Creating Events ................................................... 5-78
5.4.2. Changing Events ID ............................................ 5-78
5.4.3. Removing Events ............................................... 5-79
5.4.4. Copying / Cutting / Pasting Events ......................... 5-79
5.4.5. Drag and drop support ........................................ 5-79
5.4.6. Disabling Events ............................................... 5-79
5.4.7. Changing Time Resolution .................................... 5-80
5.5. Detailed Display View ............................................... 5-81
5.5.1. Item Name Section ............................................... 5-82
5.5.2. Properties Section ................................................ 5-82
5.5.3. Descriptors List Section ........................................... 5-83
5.5.4. Descriptor Management Section .............................. 5-83

Chapter 6. Scheduler Management ............................. 6-84
6.1. General .............................................................. 6-84
6.2. Scheduler Dialog ................................................... 6-84
6.3. Task Parameters .................................................... 6-85
6.3.1. General Tab ...................................................... 6-85
6.3.2. Commands Tab .................................................. 6-86
6.3.3. Timing Tab ........................................................ 6-100

Appendix A RTM 3300/3800 Configuration .................. 105
A.1 Checking tables status ............................................. 105
A.2 Checking PID and Service numbers .......................... 106
A.3 Configure the Mux to Support ASI Interface .................. 107
A.4 Configure the Mux to Support UDP Interface ................. 108
LIST OF FIGURES

Figure 1-1: Typical DVB Environment Application ........................................ 1-13
Figure 1-2: PSI/SI Generator – Standard Application ...................................... 1-14
Figure 1-3: PSI/SI Generator – Distributed Application ................................. 1-15
Figure 3-1: PSI/SI Generator PSI/SI Management Window ............................ 3-26
Figure 3-2: PSI/SI Management Window Menu Bar ...................................... 3-27
Figure 3-3: Connect to Database Dialog ..................................................... 3-31
Figure 3-4: Create New Database Dialog .................................................. 3-33
Figure 3-5: Backup Database Dialog ......................................................... 3-34
Figure 3-6: Restore Database Dialog ........................................................ 3-35
Figure 3-7: Send Tables Dialog .................................................................. 3-36
Figure 3-8: Receive Tables Dialog ............................................................. 3-38
Figure 3-9: PSI/SI Tables Rate Measurements Dialog .................................. 3-39
Figure 3-10: Profiles Dialog ..................................................................... 3-40
Figure 3-11: Data Carousels Log ............................................................... 3-41
Figure 3-12: Stream Configuration Dialog ................................................ 3-43
Figure 3-13: PID Contents Dialog ............................................................. 3-46
Figure 3-14: PSI/SI Generator PSI/SI Management Window ........................ 3-49
Figure 3-15: Stream Item Context Menu .................................................... 3-50
Figure 3-16: New Service ID Dialog .......................................................... 3-51
Figure 3-17: Change PID Dialog ................................................................ 3-52
Figure 3-18: Disabled Items in the PSI/SI Management Tree ....................... 3-54
Figure 3-19: PSI/SI Generator PSI/SI Management Window ........................ 3-56
Figure 3-20: Network Properties section .................................................... 3-58
Figure 3-21: Stream Properties section ...................................................... 3-58
Figure 3-22: Stream Properties section ...................................................... 3-59
Figure 3-23: PID Properties section ........................................................... 3-59
Figure 3-24: Properties section – Advanced Management .......................... 3-60
Figure 3-25: Descriptor List Section ............................................................ 3-61
Figure 3-26: Select Descriptor Dialog ....................................................... 3-62
Figure 3-27: Descriptor Management Section ............................................ 3-63
Figure 3-28: Proprietary Descriptors ........................................................ 3-64
Figure 4-1: Bouquet Management Window ............................................... 4-65
Figure 5-1: Event Management Window Menu Bar ................................... 5-70
Figure 5-2: Find Event Dialog .................................................................. 5-76
Figure 5-3: Event Management Main Display View ................................... 5-77
Figure 5-4: New Event ID Dialog ............................................................... 5-78
Figure 5-5: Disabled Event in the Calendar ............................................... 5-80
Figure 5-6: Event Management Detailed Display View ............................... 5-81
Figure 5-7: Data Section Example .............................................................. 5-82
Figure 6-1: Scheduler Dialog ..................................................................... 6-84
Figure 6-2: Scheduler Dialog – Commands Tab ............................... 6-86
Figure 6-3: Scheduler Dialog – Enable ID Command Parameters ..... 6-88
Figure 6-4: Scheduler Dialog – Send TCP Message Command Parameters 6-90
Figure 6-5: Scheduler Dialog – Run External File Command Parameters ... 6-91
Figure 6-6: Scheduler Dialog – Backup Database Command Parameters ... 6-92
Figure 6-7: Scheduler Dialog – Clear Log Command Parameters ............ 6-93
Figure 6-8: Scheduler Dialog – Delete Old Events Command Parameters ... 6-94
Figure 6-9: Scheduler Dialog – Delete All Events Command Parameters ... 6-95
Figure 6-10: Scheduler Dialog – Export Data Command Parameters .......... 6-96
Figure 6-11: Scheduler Dialog – Import Data Command Parameters .......... 6-97
Figure 6-12: Scheduler Dialog – Exporting Log Command Parameters ........ 6-98
Figure 6-13: Scheduler Dialog – Change PCR PID Command Parameters .... 6-99
Figure 6-14: Scheduler Dialog – Timing Tab - Never ......................... 6-100
Figure 6-15: Scheduler Dialog – Timing Tab - Once .......................... 6-101
Figure 6-16: Scheduler Dialog – Timing Tab - Daily ......................... 6-102
Figure 6-17: Scheduler Dialog – Timing Tab - Weekly ......................... 6-103
Figure 6-18: Scheduler Dialog – Timing Tab - Monthly ....................... 6-104
Figure A-1: Auto Table Configuration on the Multiplexer Terminal ........ 105
Figure A-2: Screen Shot of PID List on the Multiplexer Terminal ........... 106
INTRODUCTION

Scopus Video Networks Ltd. takes great pride in delivery of its products and makes every endeavor to ensure its clients full satisfaction.

On behalf of the whole Scopus team, we would like to extend our congratulations on your investment in the SI-3050 PSI/SI Generator.

ABOUT THIS MANUAL

The Scopus SI-3050 User Manual provides information and instructions for using the Scopus SI-3050 PSI/SI Generator. This manual is comprised of the following chapters:

Chapter 1 Overview
Chapter 2 Installation
Chapter 3 PSI/SI Management Window
Chapter 4 Bouquets Management Window
Chapter 5 Event Management (EPG) Window
Chapter 6 Scheduler Management

INTENDED AUDIENCE

It is assumed throughout this manual that personnel have general knowledge about the Scopus system concept and architecture, Scopus building blocks as well as the Scopus SI-3050 application and capabilities.
WARRANTY

SCOPUS Video Networks Ltd. warrants that the product and any part thereof, including but not limited to spare parts will, when properly installed, conform to SCOPUS Video Networks Ltd. published specifications. Also, the product and any parts thereof, including but not limited to spare parts, will be free from defects deriving from faulty workmanship and faulty materials under standard use and service, for a period of twelve (12) months following the date of manufacture thereof.

The supply of spare parts at a reasonable cost shall be available for a period of three (3) years from the date of delivery.

This warranty does not cover ordinary wear and tear of the product or other defects due to circumstances beyond SCOPUS Video Networks Ltd. control, such as: unsuitable operating means, chemicals, electro-mechanical issues, or electrical influences and damages, which may be caused by interference by the CUSTOMER or any unauthorized third party.

Defective cards and assemblies will be sent to SCOPUS Video Networks Ltd. for repair. The repaired cards and assemblies will be returned to the CUSTOMER within 30 days from their receipt by SCOPUS Video Networks Ltd.

Cards and assemblies repaired during the twelve (12) month warranty period will carry a warranty of six (6) months from date of repair or until the end of original warranty period, whichever is the later date.

SCOPUS Video Networks Ltd. sole liability under this warranty shall be limited to the repair or replacement with equivalent units at SCOPUS Video Networks Ltd. facilities, of any product or parts thereof that do not conform to SCOPUS Video Networks Ltd. published specifications or that are defective in material or workmanship, as specified above. The expense of installing repaired or replaced parts shall be borne by the CUSTOMER.

SCOPUS Video Networks Ltd. sole obligation under this warranty is to be the supplier of the product to the CUSTOMER and to provide such services as set out in this warranty according to the SCOPUS Video Networks Ltd. terms and conditions provided for herein. In no event will SCOPUS Video Networks Ltd. be liable to the CUSTOMER for any: business expenses, loss of profits, or incidental, indirect, or consequential damages, however caused, unless such expenses, loss, or damages shall have derived from an infringement of patents of copyrights.

THE WARRANTIES STATED HEREIN ARE EXCLUSIVE AND ARE EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Beyond the warranty period, SCOPUS Video Networks Ltd. shall repair or replace defective cards and assemblies according to its standard and relevant price list at such time. Cards and assemblies thus repaired shall carry a warranty of six (6) months.

TECHNICAL SUPPORT

In case of technical problems with the system or one of its components, refer to additional System Documentation. Usually, this may save time in resolving technical difficulties.

If you are not able to resolve the problem, call your local distributor for technical support.
Chapter 1.
Overview

1.1. Technological Edge

The Scopus SI-3050 PSI/SI Generator is a modular, scalable and configurable, yet powerful and user-friendly distributed application, which provides the user the following capabilities:

- Generation of static and dynamic DVB Service Information (SI) and MPEG-2 Program Specific Information (PSI) tables.
- Generation of Electronic Program Guides (EPGs).
- Injection of the PSI/SI table streams into stream multiplexers (such as the Scopus IVG-7000/8000 Series of Intelligent Video Gateways) in broadcast head-end systems.
- Execution of scheduled tasks at predefined times.
- Import of data from different formats (Including XML and Excel formats).
- Handling the entire PSI/SI information in an intuitive, system-oriented manner, without having to deal with table details where it is not needed.

The PSI/SI Generator provides management for the following:

- Network Stream and Service Management; manages the network components parameters: networks, streams, services and PIDs.
- Events Management; manages the services events parameters. Each service has its own event management window.
- Bouquets Management; manages the network bouquets parameters. Each network has its own bouquet management window.
1.2. **HIGHLIGHTS AND BENEFITS**

The SI-3050 PSI/SI Generator is a powerful, yet easy to use Windows 2000 / XP software application for generation, editing and insertion of PSI/SI tables. The following is a summary of the key features of the SI-3050:

**MPEG-2 PSI Tables Generation**

The following MPEG-2 Program Specific Information (PSI) tables are generated by the PSI/SI Generator:

- PAT – Program Association Table
- PMT – Program Map Table
- CAT – Conditional Access Table

**DVB SI Tables Generation**

The following DVB Service Information (SI) tables are generated by the PSI/SI Generator:

- NIT – Network Information Table
- SDT – Service Description Table
- EIT – Event Information Table (both Present/Following and Schedule)
- BAT – Bouquet Association Table
- TDT – Time and Date Table
- TOT – Time Offset Table.

**PSI/SI Descriptors**

The PSI/SI Generator generates flexible, future-proof design, using standard and private (generic) descriptors. The generator enables insertion of descriptors in compliance with the following:

- ETSI EN-300 468, for DVB SI descriptors.
- ISO/IEC 13818-1, for MPEG-2 PSI descriptors.
**EPG Generation**

The Electronic Program Guides (EPGs) generated by the application has the following capabilities:

- User Friendly Graphic User Interface (GUI) for building an up-to-date overview of present and future broadcast services.
- Set parental lock based on different age groups.
- Personalization of viewing by using filtering of favorite channels and event categories.
- Supports multi-language (Unicode or other character tables) descriptors.

**Central Database and Information Consistency**

The PSI/SI Generator generates a central database with the following capabilities:

- All information is stored in relational (SQL) database.
- Provides local or remote database management.
- Provides optional support for multi-terminal (distributed) configuration.
- Allows backup/restore of data stored in the database.

**Interfaces**

- 10/100 BaseT interface for streaming tables over UDP/IP, Unicast or Multicast.
- ASI interface for table generation into any multiplexer.
1.3. APPLICATIONS

The PSI/SI Generator can be used in a wide range of applications, such as:
- Fixed Distribution / Contribution
- Satellite, DVB-T, MMDS
- Cable TV Head Ends
- Digital Turnaround
- Direct To Home (DTH)

1.3.1. PSI/SI Generator Integration in DVB Application

Figure 1-1 illustrates the PSI/SI Generator in a typical video distribution system. The entire network, stream, service and event information is stored in a central database. This information is generated, configured, maintained and monitored by the PSI/SI Generator.

Figure 1-1: Typical DVB Environment Application
1.3.2. Standard PSI/SI Application

Figure 1-2 shows a PSI/SI Generator. The database and the Data Carousel are on the same server computer. They work independently until the PSI/SI Generator instructs the Data Carousel to get the tables from the database and continue sending them independently.

The PSI/SI Generator User Interface is on the server as well.

![Diagram of PSI/SI Generator - Standard Application]

1.3.3. Distributed PSI/SI Application

Figure 1-3 shows three PSI/SI Generator GUIs on three different remote client computers. The server computer is connected to all the client computers and holds the common single PSI/SI database. The server is also connected to two computers with Data Carousels. One Data Carousel is redundant. Each Data Carousel sends PSI/SI tables to two Multiplexers.

The Matrix maps the two working Multiplexers to be broadcast in the Uplink. In case of a failure in one of the two Multiplexers or Data Carousel 1, the matrix can be rerouted to the redundant Multiplexers and Data Carousel 2.

Each of the three PSI/SI Generator GUIs can manage the PSI/SI database.
Figure 1-3: PSI/SI Generator – Distributed Application
1.4. **FUNCTIONAL DESCRIPTION**

The SI-3050 PSI/SI Generator is based on a distributed architecture functionally divided into three components:

- The Database Server component, explained in paragraph 1.4.1
- The Data Carousel component, explained in paragraph 1.4.2
- The PSI/SI Generator graphical user interface (client), explained in paragraph 1.4.3

The PSI/SI Generator main purpose is to generate PSI/SI tables. Paragraph 1.5 defines the PSI/SI tables.

1.4.1. **PSI/SI Database**

The PSI/SI Generator keeps its information on a relational (SQL) database. The PSI/SI database contains all the table parameters and descriptors generated.

The PSI/SI database is updated and managed by the PSI/SI User Interface. The user is asked to specify a PSI/SI Database name and location before starting to work on the PSI/SI Generator. This feature enables the user to manage several PSI/SI databases on different sites.

The PSI/SI Client can work with one database at a time. The database is located on a PSI/SI server computer and can be controlled by any remote client computer.

1.4.2. **Data Carousel**

The Data Carousel is a computer program that organizes and sends the information from the database to the Multiplexer. The Data Carousel is running as service application. The Data Carousel displays a ‘chip’ icon on the system tray in the bottom of the screen. Double clicking the ‘chip’ icon displays the Data Carousel main screen. The main screen shows errors should they occur and allows to select a database containing the data to be generated.

The Data Carousel sends its data through UDP (over an IP network) or through an ASI output. The Data Carousel obtains it’s own copy of the PSI/SI database information at start up, or when the user chooses the “Send Tables” command from the PSI/SI Generator.
EIT Present / Following data is also refreshed when an event has stopped or started. EIT Schedule data is also refreshed every midnight.

The Data Carousel is installed on a computer that is connected to the Multiplexer. Several Data Carousels can be installed for large networks on different computers. Every Data Carousel can be controlled separately to send specific streams to different Multiplexers by providing the Multiplexer IP address to the PSI/SI Generator.

One Data Carousel can send PSI/SI information of a number of streams simultaneously. For each stream, it is possible to configure more than one target (multiplexers). This enables a variety of system configurations.

1.4.3. PSI/SI Generator Remote Client

The PSI/SI Generator Client manages the PSI/SI database, builds it, and controls the Data Carousels. It provides an easy to use interface for scheduling events and adding different descriptors to the PSI/SI tables.

Changes made with the PSI/SI Generator Client are saved immediately on the database. However, the changes take affect only when the Send Tables command is executed.

The PSI/SI Generator Client can be located on any client computer connected to the PSI/SI database server computer over an IP network or on the server itself. Several PSI/SI Generator Clients can simultaneously manage the same PSI/SI database from different client computers.
1.5. PSI/SI TABLES

The PSI/SI Generator can automatically generate the tables based on the PSI/SI database information. The IVG-7000/8000 Series, or another multiplexer, can also automatically generate a basic form of most of those tables. Every method of creation has its advantages. Generating the tables can be shared between the Multiplexer and the PSI/SI Generator as long as two table types are not created twice.

Creating tables with the PSI/SI Generator obligates the user to synchronize mutual parameters in the PSI/SI Generator to match those on the Multiplexer.

The following sections provide explanation on the various PSI/SI tables; MPEG-2 Program Specific Information tables (MPEG-2 PSI tables, see details in 1.5.1) and DVB Service Information tables (DVB SI tables, see details in 1.5.2).

1.5.1. MPEG-2 PSI Tables Description

1.5.1.1. Program Association Table (PAT)

The Program Association Table (PAT) is like a root directory for the transport stream. The PAT lists all the programs in the stream and provides the PID (Packet Identifier) value for the Program Map Table (PMT) associated with each program. The PAT can also contain the PID number for the Network Information Table (NIT), which provides access to other transport streams in the network. The decoder is always able to find the PAT (if present in the stream) since it is always in packets with a PID value of 00.

1.5.1.2. Program Map Table (PMT)

The Program Map Table (PMT) provides a description for each program in a transport stream. This table literally acts as the map for a program, listing the PID values for its video, audio, clock reference and data components. With this information, the decoder can locate the audio and video for the program and display them synchronously.
1.5.1.3. **Conditional Access Table (CAT)**

The Conditional Access Table (CAT) provides a mechanism for decoders to find Entitlement Management Messages (EMMs) in the transport stream. EMMs update the subscription options or pay-per-view rights for each subscriber or for groups of subscribers. The CAT lists the EMMs in the transport stream and gives the associated PID values.

1.5.2. **DVB – SI Tables Description**

1.5.2.1. **Time and Date Table (TDT)**

This table provides the present UTC date and time, which can be adjusted according to time zone and presented on screen for the viewer.

1.5.2.2. **Timing Offset Table (TOT)**

This table contains the UTC time and date, along with the local time offset.

*NOTE*

*It is possible for the TDT and TOT to synchronize the PC time with any reference PC using NTP (network time protocol) client and NTP server.*

1.5.2.3. **Network Information Table (NIT)**

The Network Information Table (NIT) provides information regarding the transmission system, as well as other transport streams in the network.

A Network is a system of one or more transport streams controlled by a single content provider. The Network Information Table (NIT) contains information regarding the physical organization of the transport streams carried on a single network, including the tuning parameters that enable the receiver to change channels at the viewer’s command with little or no delay. Tuning parameters are specific to the type of transmission assigned to the network - terrestrial, cable or satellite. This table also includes characteristics about the network itself. There are two types of NIT:

- “NIT actual” is the NIT table of the network containing the current stream
- “NIT other” are the NIT tables of the other networks in this profile (not including the network containing the current stream)
1.5.2.4. **Service Description Table (SDT)**

A Service is a sequence of programs under the control of a broadcaster, which can be broadcast as part of a schedule. The Service Description Table (SDT) provides information about the services available in the network, including the name of the service provider and the textual description of the channel. There are two types of SDT:

- “SDT actual” is the SDT table of the current stream
- “SDT other” are the SDT tables of the other streams in the network containing the current stream (not including the current stream itself)

1.5.2.5. **Bouquet Association Table (BAT)**

A Bouquet is a commercial offering, or a group of services that can be purchased as a single product. The Bouquet Association Table (BAT) describes the services available in a given bouquet.

1.5.2.6. **Event Information Table (EIT)**

An event is a collection of elementary streams with a common time base set to start and end at the same time. (We often refer to events as “TV programs”.) The Event Information Table (EIT) provides information about events in the network, such as their start time and duration. Two different types of EITs can be transmitted at the same time: EIT Present and Following and the EIT Schedule. The EIT Present-following describes the event currently being broadcast and the next event to be broadcast on that service. The EIT Schedule lists events available on the network for anywhere from the next few hours to the next few days, depending on the service provider’s implementation. There are two types of EIT:

- “EIT actual” are the EIT tables of the services in the current stream
- “EIT other” are the EIT tables of the services in other streams in the network containing the current stream (not including the services in the current stream)
1.6. **PLATFORM SPECIFICATIONS**

The following are the hardware and software specifications for the PSI/SI Generator workstation:

- IBM x3250 1RU Dual-Core Pentium Server
- 4GB RAM
- 10/100Base T UDP Interface
- ASI Interface
- Microsoft® Windows XP/2000™
Chapter 2. INSTALLATION

The installation program of the PSI/SI Generator is built out of several easy and intuitive dialogs. Follow the steps below to install the PSI/SI Generator: (Unless already installed in the factory)

1. Remove older versions of the PSI/SI Generator software if installed on the computer.
2. Shut down the computer and connect the supplied dongle to the LPT port of the computer.
3. Turn on the computer.
4. Run the installation program. Wait for the welcome dialog.
5. Click the [Next] button to display the Destination Location dialog.
6. Choose a directory for the installation. It is recommended to use the default directory.
7. Click the [Next] button to display the Select Components dialog.
7. Select which components will be installed. For full installation, make sure all three components are selected.

8. Click the [Next] button to display the Start Installation dialog.

9. Click the [Next] button on the Start Installation dialog to start copying and installing the PSI/SI Generator files.

10. Click the [Next] button. This will open the Firebird installation program.

11. Click the [Next] button to display the License Agreement dialog.

12. Read the license agreement and click the [Yes] button to display the Information dialog.

13. Click the [Next] button on the Information dialog to display the Select Destination Directory dialog.
14. Choose a directory for the installation. It is recommended to use the default directory.

15. Click the [Next] button to display the **Select Components** dialog.

16. On the **Select Components** dialog, select from the drop down list the ‘Full installation of server and development tools’ option and Click the [Next] button to display the **Select Start Menu Folder** dialog.

17. Click the [Next] button on the **Select start menu folder** dialog to display the **Select Additional Tasks** dialog.

18. Make sure the following options on the **Select additional tasks** dialog will be selected:
   - Create a Menu Group
   - Install IBServer using the guardian service
   - Start Firebird service when setup complete

19. Click the [Next] button to display the **Ready to Install** dialog.

20. Click the [Install] button on the **Ready to install** dialog to start copying and installing the Firebird server.
21. Click the [Finish] button on the PSI/SI Generator final screen. After a few moments, the Install dialog Displays.

22. The Installation program must restart the computer to complete the installation. Click [OK] on the Install dialog to complete the installation and restart the computer.
Chapter 3.

PSI/SI MANAGEMENT WINDOW

3.1. GENERAL

The PSI/SI Management window is the PSI/SI Generator main window and it manages network, streams, services and PID related parameters. The PSI/SI Generator displays the PSI/SI Management window after connecting to the PSI/SI database.

Figure 3-1 shows the PSI/SI Management window.

The window consists of the following main sections:

a. **Menu Bar** – provides management commands. See paragraph 3.2.
b. **Tool Bar** – provide database connectivity commands. See paragraph 3.3.
c. **Main Display View** - The Left side of the window shows a hierarchical view of the PSI/SI Management Tree. See paragraph 3.4.
d. **Detailed Display View** - The right side of the window shows the details of the selected item on the PSI/SI Management Tree. See paragraph 3.5.

![Figure 3-1: PSI/SI Generator PSI/SI Management Window](image-url)
3.2. **MENU BAR**

This section describes the PSI/SI management Menu bar. Paragraph 3.2.1 describes the structure of the menu bar and a brief description on each command. The following paragraphs explain some of the commands and dialog boxes in more details.

### 3.2.1. Menu Bar Structure

The main menu bar of the network display is displayed in Figure 3-2 and is summarized in Table 3-1.

![Figure 3-2: PSI/SI Management Window Menu Bar](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database→Connect...</td>
<td>Opens the ‘Connect to Database’ dialog. Refer to paragraph 3.2.2 for more details.</td>
</tr>
</tbody>
</table>
### Table 3-1: Network Display Menu Bar

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database</strong>→<strong>Disconnect</strong></td>
<td>Disconnects from current database. This command closes all open windows in the PSI-SI Generator. Refer to paragraph 3.2.3 for more details.</td>
</tr>
<tr>
<td><strong>Database → New...</strong></td>
<td>Opens the ‘Create New Database’ dialog. Refer to paragraph 3.2.4 for more details.</td>
</tr>
<tr>
<td><strong>Database → Backup...</strong></td>
<td>Opens the Backup dialog. The Backup dialog let the user make backups of the database. Refer to paragraph 3.2.5 for more details.</td>
</tr>
<tr>
<td><strong>Database → Restore...</strong></td>
<td>Opens the Restore dialog. The Restore dialog let the user restore a previously saved backup. Refer to paragraph 3.2.6 for more details.</td>
</tr>
<tr>
<td><strong>Database → Exit</strong></td>
<td>The Exit command closes the PSI/SI Generator user interface.</td>
</tr>
</tbody>
</table>

**NOTE**

The Data Carousel will continue to work properly after the PSI/SI Generator user interface is closed.

| **Edit → New [Item]** | Create a new item in the PSI/SI Management Tree. For details see section 3.4.1. The [Item] type is depended on the currently selected object.          |
| **Edit → Change [Item] ID** | Changes the selected item's ID. For details see section 3.4.3. The [Item] type is depended on the currently selected object.                          |
| **Edit → Delete [Item]** | Deletes an item from the PSI/SI Management Tree. Refer to paragraph 3.4.4 for more details. The [Item] type is depended on the currently selected object. |
| **Edit → Cut**         | Cuts a PSI/SI Management Tree item from the Main Display view. The Cut command is used for moving PSI/SI Management Tree items to different places (using the Paste command). The Cut command works only on networks, streams, services, or PIDs. |
Table 3-1: Network Display Menu Bar

<table>
<thead>
<tr>
<th>Item</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong> → Copy</td>
<td>Copies a PSI/SI Management Tree item from the Main Display view. The Copy command is used for copying PSI/SI Management Tree items to different places (using the Paste command). The Copy command works only on networks, streams, services, or PIDs.</td>
</tr>
<tr>
<td><strong>Edit</strong> → Paste</td>
<td>Pastes a PSI/SI Management Tree item under a selected item in the PSI/SI Management Tree.</td>
</tr>
<tr>
<td><strong>Edit</strong> → [Item] Enabled</td>
<td>Enable or disable an item. Refer to paragraph 3.4.8 for more details. The [Item] type is depended on the currently selected object.</td>
</tr>
<tr>
<td><strong>Edit</strong> → Import XXX</td>
<td>The PSI/SI Generator has the ability to import events from external files. Refer to paragraph 3.4.9 for more details.</td>
</tr>
<tr>
<td>Carousel → Send…</td>
<td>Opens the ‘Send Tables’ dialog. Refer to paragraph 3.2.7 for more details.</td>
</tr>
<tr>
<td>Carousel → Send to All</td>
<td>Sends the tables to all data carousels currently connected to the active database. Each Data Carousel uses its last profile.</td>
</tr>
<tr>
<td>Carousel → Receive…</td>
<td>The Receive command receives a video transport stream and builds the PSI/SI Generator Database according to the video stream PSI/SI Tables. Refer to paragraph 3.2.8 for more details.</td>
</tr>
<tr>
<td>Carousel → Rates…</td>
<td>Opens the ‘PSI/SI Tables Rate Measurement’ dialog. Refer to paragraph 3.2.9 for more details.</td>
</tr>
<tr>
<td>Tools → Profiles…</td>
<td>Opens the Profiles dialog. Refer to paragraph 3.2.10 for more details.</td>
</tr>
<tr>
<td>Tools → Scheduler…</td>
<td>Opens the Scheduler dialog. Refer to Chapter 6 for more details.</td>
</tr>
<tr>
<td>Tools → Log…</td>
<td>Displays the system event Log. Refer to paragraph 3.2.11 for more details.</td>
</tr>
<tr>
<td>Additional → Bouquets</td>
<td>Opens the Bouquets Management Window. Refer to Chapter 1 for more details.</td>
</tr>
</tbody>
</table>
### Table 3-1: Network Display Menu Bar

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional → Configure</strong></td>
<td>Opens the Stream Configuration dialog. Refer to paragraph 3.2.12 for more details.</td>
</tr>
<tr>
<td><strong>Additional → Events</strong></td>
<td>Opens the Event Management Window. Refer to Chapter 5 for more details.</td>
</tr>
<tr>
<td><strong>Additional → Content</strong></td>
<td>Opens the PID Contents dialog. Refer to paragraph 3.2.13 for more details.</td>
</tr>
<tr>
<td><strong>Window → Cascade</strong></td>
<td>Cascades all the opened windows</td>
</tr>
<tr>
<td><strong>Window → Tile Horizontally</strong></td>
<td>Tiles Horizontally all the opened windows.</td>
</tr>
<tr>
<td><strong>Window → Tile Vertically</strong></td>
<td>Tiles Vertically all the opened windows.</td>
</tr>
<tr>
<td><strong>Window → Minimize All</strong></td>
<td>Minimizes all the opened windows.</td>
</tr>
<tr>
<td><strong>Windows → Arrange All</strong></td>
<td>Arranges all minimized windows.</td>
</tr>
<tr>
<td><strong>Window → Close</strong></td>
<td>Closes the selected window.</td>
</tr>
<tr>
<td><strong>Window → Window List</strong></td>
<td>The ‘Windows list’ lists on the menu all the opened windows. Selecting a window from the list moves the focus to the selected window.</td>
</tr>
<tr>
<td><strong>Help → PSI/SI Generator Help</strong></td>
<td>Opens the Program on-line help file.</td>
</tr>
<tr>
<td><strong>Help → About</strong></td>
<td>Displays the About dialog.</td>
</tr>
</tbody>
</table>
3.2.2. Connect to Database

Before starting to use the PSI/SI Generator, a database must be created or connected to. The ‘Connect to Database’ dialog defines an existing database to be used with the PSI/SI Generator.

The ‘Connect to Database’ dialog can be opened by choosing File→Connect… from the PSI/SI management menu bar. By default, the PSI/SI opens the last used profile when connected. When the last used profile is unknown, the PSI/SI opens the Profiles dialog. Refer to paragraph 3.2.10 for more detail regarding the profiles dialog.

Figure 3-3 shows the ‘Connect to Database’ dialog. Table 3-2 explains the ‘Connect to Database’ dialog components.

![Connect to Database Dialog](image)

**Figure 3-3: Connect to Database Dialog**

**NOTE**

The ‘Connect…’ command is disabled after a database connection has been achieved. To connect to a different database – close the current connection and then reconnect to a new database.
### Table 3-2: Connect to Database Dialog parameters

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Server / Remote Server</td>
<td>Chooses between a database on this computer, or on a remote server.</td>
</tr>
<tr>
<td>Server IP or Name</td>
<td>Selects the server IP address or the server name, only if “Remote Server” is selected.</td>
</tr>
<tr>
<td>Database</td>
<td>Changes the database name and directory.</td>
</tr>
<tr>
<td>Notification Server Port</td>
<td>Selects the Notification server port. This parameter is set during installation and should not be changed.</td>
</tr>
<tr>
<td>User Name</td>
<td>Changes the user name. This parameter is set during installation and should not be changed.</td>
</tr>
<tr>
<td>Password</td>
<td>Changes the password. This parameter is set during installation and should not be changed.</td>
</tr>
</tbody>
</table>

### 3.2.3. Disconnect from Database

Choosing the ‘Disconnect from Database’ command will close all active windows on the PSI/SI Generator and will disconnect from the current database.

After disconnecting from a database, the user can reconnect to another database or create a new database.
3.2.4. Create New Database

The 'New...' command from the PSI/SI management menu bar opens the 'Create New Database' dialog.

The 'Create New Database' dialog is identical to the 'Connect to Database' dialog. See Figure 3-4. The 'Create New Database' dialog creates a new database and connects to it. The PSI/SI Generator must be connected to a database before starting to operate.

![Create New Database Dialog](image)

Figure 3-4: Create New Database Dialog
3.2.5. Backup Database Dialog

A special backup feature is provided to make a backup of the database. The Backup Database dialog saves a backup file of the database on the location specified in the Filename parameter. The Backup Database dialog is shown in Figure 3-5.

![Backup Database Dialog](image)

Figure 3-5: Backup Database Dialog

On a local database, the backup file can be saved anywhere using the browse icon next to the Filename parameter. When the database is remote on the server, the backup must be saved in the server computer. The browse icon is not displayed when the database is remote.
3.2.6. Restore Dialog

The Restore Database dialog restores a previously backed-up file. The restored database is not automatically connected to the PSI/SI Generator. To connect the database, the user should disconnect from the currently opened database and then reconnect to the restored database.

Figure 3-6 shows the Restore Database dialog.

![Restore Database Dialog]

The Restore Database dialog contains the following parameters:

a. **Local Server / Remote Server** – the location of the database after restoration.

b. **Server IP or Name combo box** – the server name or IP address. This parameter is valid only when the database is on a remote server.

c. **Database edit box** – The database name and directory.

d. **User Information** – the user name and password. Those parameters should not be changed.

e. **Filename** – the backup file to restore.
3.2.7. Send Tables Dialog

The 'Send Tables' dialog manages the Carousels data dispatch.

The 'Send Tables' dialog is opened by choosing Carousels→Send... from the PSI/SI Management window menu bar.

Figure 3-8 shows the 'Send Tables' dialog.

![Send Tables Dialog]

Figure 3-7: Send Tables Dialog

The 'Send Tables' dialog has a Data Carousels list. The Data Carousel list contains all Data Carousels that are connected to the same database file. Each Data Carousel is assigned a profile. Refer to paragraph 3.2.10 for more detail regarding profiles.

The Send Tables dialog has the following operations:

a. Modify a Data Carousel
   1. Double click on the profile name. A selection box with all available profiles is opened.
   2. Choose a profile from the list.

b. Send tables to Data Carousels
   1. Select the Data Carousels from the list by clicking on them. Several Data Carousels may be selected.
   2. Select whether all the tables are refreshed or only the updated tables are refreshed when the [Send] button is pressed.
   3. Press the [Send] button. The updated profiles have been sent to the selected Data Carousels.
NOTE

The process of sending tables of large data bases might take a few minutes to execute, however it runs in the background without interfering the carousels or GUI operation.

c. Refresh the Data Carousel display
   Press the [Refresh] button. The Data Carousel list is updated.

d. Close the dialog
   Press the [Close] button. The Sent Tables dialog is closed.

NOTE

The Data Carousels -> Send to All menu command sends the data to all connected Data Carousels.

3.2.8. Receive Tables Dialog

The Receive Tables dialog enables the user to receive tables from a video transport stream from a specific Data Carousel. The Data Carousel builds PSI/SI Generator database profile according to the PSI/SI tables found in the video stream.

The 'Receive Tables' dialog is opened by choosing Carousels -> Receive... from the PSI/SI Management window menu bar. Figure 3-8 shows the Receive Tables dialog.
Figure 3-8: Receive Tables Dialog

The Receive Tables dialog has the following parameters:

a. **Data Carousel** – Select a Data Carousel to handle the process of receiving the tables from the transport stream

b. **Interface** – Select the interface of the transport stream:
   1. None – default setting. Do not receive any transport stream.
   2. File – Receive a transport stream from a file. A directory and a file extension parameter are needed

c. **Advanced Settings** – The Advanced Settings is for advanced users and for advanced purposes only!

d. **Notification Setting** – notify the user when the process is complete. The process time may be very lengthy.

The received PSI/SI tables are kept in a new profile. The new profile is created automatically by the PSI/SI Generator program.
3.2.9. PSI/SI Tables Rate Measurements Dialog

The ‘PSI/SI Tables Rate measurements’ dialog may be opened by choosing **Carousel → Rates...** from the PSI/SI Management window menu bar.

Figure 3-9 shows the ‘PSI/SI Tables Rate measurements’ dialog.

![Figure 3-9: PSI/SI Tables Rate Measurements Dialog](image)

The ‘PSI/SI Tables Rate Measurements’ dialog displays a list showing the following parameters:

- **Carousel** – the data carousel name. The table shows all the available data carousels connected to the selected database.
- **Stream** – shows all the streams in every data carousel.
- **Rate [Bps]** – shows the actual stream rate in Bps units.
- **Estimated [Bps]** – shows an estimated rate of the stream in Bps units. The estimated rate is calculated by the information stored in the database and should be close to the actual rate.

The ‘PSI/SI Tables Rate Measurements’ dialog has the following two buttons:

- **[Refresh]** button – Refreshes the information presented in the table.
- **[Close]** button – closes the dialog.
3.2.10. Profiles Dialog

The PSI/SI Generator may control more than one set of DVB elements. The PSI/SI tables are built using the DVB elements. Each set of DVB elements is managed in its own profile and in a separate PSI/SI Management window. All profiles are saved under the same database. Each Data Carousel can send one profile at a time. Figure 3-10 shows the Profiles dialog.

Figure 3-10: Profiles Dialog

The Profiles dialog has a list of all the profile names. The Profiles has the following buttons:

a. [Open] button – opens the PSI/SI Management window that contains the selected profile.


c. [Delete] button – deletes the selected profile from the profile list.

⚠️ CAUTION

ALL DVB NETWORK RELATED DATA WOULD BE LOST AFTER DELETION!

d. [Rename] button – rename the profile name.

e. [Close] button – closes the Profiles dialog.
3.2.11. Log Dialog

The Data Carousels Log may be opened by choosing Tools→Log... from the PSI/SI Management window menu bar.

Figure 3-11 shows the Carousels log.

![Data Carousels Log](image)

The log keeps a table of events with the following columns:

- **Time of Events** – date and time of the event
- **Event Source** – The computer name, where the event occurred. The PSI/SI Generator can have several Data Carousels on several different computers.
- **Source Type** – The event can be cause by a Data Carousel or by a Scheduler task.
- **Event Description** – describes the event. In case of a Scheduler task error, the description includes the exact command that failed in the task.

The Log has the following four buttons in the bottom of the log:

- **[Export]** button – Exports the log to an HTML format and saves it in the ‘Logs’ directory under the PSI/SI program directory.
- **[Clear]** button – Clears the events in the log.
- **[Refresh]** button – Refreshes the events display.
- **[Close]** button – Closes the log window.
3.2.12. Stream Configuration

The stream configuration dialog manages the table creation process of the selected stream item from the PSI/SI Management Tree. The stream configuration dialog supports multiple Multiplexers by optionally defining more than one way of sending tables.

⚠️ **CAUTION**

TABLES CAN BE CREATED BY THE MULTIPLEXER OR WITH THE PSI/SI GENERATOR. EACH OPTION HAS ITS ADVANTAGES. IT IS IMPORTANT TO CHECK THAT NO TABLE WILL BE GENERATED TWICE! REFER TO 6.3.3.5. APPENDIX A FOR CONFIGURING TABLE GENERATION ON THE MULTIPLEXER.

The PSI/SI features sending a table to multiple Multiplexers in several different ways. The feature is implemented by a list of different stream configurations. Each configuration defines the table generation differently. Pressing the [New] button creates a new configuration in the list. Pressing the [Delete] button deletes the selected configuration from the list.

The Data Carousel creates a copy of the tables for each configuration and sends to the defined Multiplexer.

To access the Stream Configuration window, from the PSI/SI Management window menu bar, go to: Additional->Configure.

Figure 3-12 shows the stream configuration dialog. Table 3-3 explains the ‘Stream Configuration’ dialog parameters.

**NOTE**

For information regarding the PSI-SI tables, refer to paragraph 1.5.
Multiple Configuration

Interface Tab

### Table 3-3: Commands Descriptions

<table>
<thead>
<tr>
<th>SECTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple</td>
<td>Multiple configurations enable to send a stream to several Multiplexers in different ways. For example, a single Data Carousel may send a stream through ASI to Multiplexer 1 and through UDP to Multiplexer 2.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Pressing the [New] button creates a new configuration in the list. Pressing the [Delete] button deletes the selected configuration from the list.</td>
</tr>
<tr>
<td>Interface Tab</td>
<td>Selects between different output types:</td>
</tr>
<tr>
<td></td>
<td>• None – No tables will be created.</td>
</tr>
<tr>
<td></td>
<td>• UDP – uses the UDP output type. Changes the address and the Port number of the Multiplexer.</td>
</tr>
<tr>
<td></td>
<td>• ASI – uses the ASI output type:</td>
</tr>
<tr>
<td></td>
<td>ASI card number – selects the ASI card number. When there is one ASI card on the computer, its number is always zero. In case of more than one ASI cards, define the card to use.</td>
</tr>
</tbody>
</table>
### Table 3-3: Commands Descriptions

<table>
<thead>
<tr>
<th>SECTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interface Tab</strong></td>
<td>• Send stuffing packet – when sending stuffing packets, the bit rate can be maintained constant. To enable constant bit rate, check the “Send Stuffing Packets” and set the “Stuffing Packets PID”.</td>
</tr>
<tr>
<td>(Cont’d)</td>
<td><strong>NOTE</strong></td>
</tr>
<tr>
<td></td>
<td>When using the IVG-7000/8000 multiplexers with the PSI/SI, the stuffing packet PID should be 0x1FFE.</td>
</tr>
<tr>
<td></td>
<td>• File – Write tables to a file (Binary format).</td>
</tr>
<tr>
<td></td>
<td>Specifies a directory to save the files and an extension name for the files.</td>
</tr>
<tr>
<td></td>
<td>• Use stuffing to fill packets groups – Some devices require receiving IP packet with 7 MPEG packets. The feature allows adding stuffing MPEG packet to transmitted IP packet.</td>
</tr>
<tr>
<td><strong>Tables Tab</strong></td>
<td>A list of all the tables that can be created using the PSI/SI Generator.</td>
</tr>
<tr>
<td></td>
<td>Only checked tables on the list will be created.</td>
</tr>
<tr>
<td></td>
<td>Clicking on the check boxes toggles between check and uncheck.</td>
</tr>
<tr>
<td></td>
<td>The table repetition time manages the repetition time in milliseconds of the currently selected table. The data carousel will wait the specified time between transmissions of the selected table.</td>
</tr>
<tr>
<td><strong>Carousels</strong></td>
<td>Manages the use of data carousels.</td>
</tr>
<tr>
<td></td>
<td>When the check box ‘Send tables by these data carousels only’ is checked – The tables are created only by the data carousels found on the data carousels list.</td>
</tr>
<tr>
<td></td>
<td>When the check box ‘Send tables by these data carousels only’ is unchecked - all the data carousels, which are configured to work with the profile containing this stream, will create the tables. (Recommended for small systems)</td>
</tr>
<tr>
<td></td>
<td>Writing the data carousel IP or name in the edit box and pressing the [Add] button will add the data carousel to the data carousel list.</td>
</tr>
<tr>
<td></td>
<td>Selecting a data carousel from the list and pressing the [Del] button will delete the data carousel from the data carousel list.</td>
</tr>
</tbody>
</table>
Table 3-3: Commands Descriptions

<table>
<thead>
<tr>
<th>SECTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Misc.</td>
<td>Allows saving system resources by limiting the number of days ahead, when updating content from the EIT. The limit ranges from 4 to 64, increased by four. To limit the EIT days, go to the Misc tab, mark the Limit EIT content checkbox, and use the arrows to select the limit number of days head.</td>
</tr>
</tbody>
</table>

The stream configuration dialog has the following operations:

a. **Modifying a configuration**
   
   Select a configuration from the configuration list and modify the parameters using Table 3-3. Apply the changes using the [Apply] button.

b. **Adding a different configuration**
   
   Press the [New] button. A new configuration named “None” appeared in the configuration list. Modify the selected configuration. The configuration name in the configuration list is changed only after the [Apply] button is pressed.

c. **Deleting a configuration**
   
   Select a configuration and press the [Delete] button. The configuration is deleted.
3.2.13. PID Contents Management

The PID contents management enables the user to specify the PID actual data. Specifying the PID actual data should be done to data PIDs only.

Figure 3-14 shows the PID contents dialog.

**NOTE**

*Use this option by advanced users only and for advanced purposes only.*

To edit a PID data, do the following:

1. Select the PID from the PSI/SI Management Tree.
2. Press the [Content] command on the Additional menu.
3. Check the [Send Content] check box.
4. Click on the General PID Content, or on other type of PID content, if installed.
   (The basic PSI/SI Generator package installs only the “General PID Content”)
5. Specify a repetition time in milliseconds units.
6. Change the parameters of the PID Content. In case of “General PID Content”, these are the Length of the data, and the data itself in hexadecimal.
7. Press the [Apply] button.
3.3. **TOOL BAR**

The PSI/SI Generator Tool bar is identical and common under all the different displays on the program. All tool bar commands can be found under the File menu commands.

The Tool bar has the following commands:

- Connect to database. See paragraph 3.2.2 for details.
- Disconnect from database. See paragraph 3.2.3 for details.
- Create a new database. See paragraph 3.2.4 for details.
- Backup Database. See paragraph 3.2.5 for details.
- Restore Database. See paragraph 3.2.6 for details.
- Create a new item to the PSI/SI Management tree. See paragraph 3.4.1 for details.
- Change an item on the PSI/SI Management tree. See paragraph 3.4.3 for details.
- Delete an item from the PSI/SI management tree. See paragraph 3.4.4 for details.
- Cut the selected object. See paragraph 3.4.5 for details.
- Copy the selected object. See paragraph 3.4.5 for details.
- Paste the selected object. See paragraph 3.4.6 for details.
Send tables to specific Data Carousels. See paragraph 3.2.7 for details.

Send the tables to all Data Carousels currently connected to the active database. Each Data Carousel uses its last profile.

Receive tables from transport stream. See paragraph 3.2.8 for details.

Display Data Carousels rate information. See paragraph 3.2.9 for details.

Manage PSI/SI profiles. See paragraph 3.2.10 for details.

Manage scheduling tasks. See chapter Chapter 6 for details.

Display the Log dialog. See paragraph 3.2.11 for details.

Opens the Bouquet management window. See Chapter 4 for details.

Opens the Stream configuration window. See paragraph 3.2.12 for details.

Opens the Event management window. See paragraph Chapter 5 for details.

Opens the PID Contents management window. See paragraph 3.2.13 for details.
3.4. **Main Display View**

The main display view shows the hierarchical PSI/SI Management Tree. See Figure 3-14.

![Main Display View](image)

Figure 3-14: PSI/SI Generator PSI/SI Management Window

The PSI/SI Management Tree on the Main display has the following levels:

a. **DVB** – the root of the tree. The root of the tree can have several Networks attached to it.

b. **Network** – a network contains streams.

c. **Stream** – a stream contains services.

d. **Service** – a service gathers several PIDs to form a program.

e. **PID** – a PID is a form of data that transmits on the stream. A PID can represent a video source, an audio source or a data source.

The Main Display manages the hierarchy of the PSI/SI Management Tree.
A new empty database contains only the DVB component on the PSI/SI Management Tree. The DVB component is the root of all components in the PSI/SI Management Tree.

Most items on the PSI/SI Management Tree have the following operations regardless of the item type (Network / Stream / Service / PID):

- Exporting all tree information to XML 3.4.1.
- Adding items. See paragraph 3.4.2.
- Changing the item ID. See paragraph 3.4.3.
- Removing the item. See paragraph 3.4.4.
- Copying / Cutting / Pasting an item. See paragraph 3.4.5.
- Drag and drop support. See paragraph 3.4.7.
- Disabling the item. See paragraph 3.4.8.

Some items on the PSI/SI Management Tree have additional actions which can be performed.

All the operations are selected from a context menu. The context menu has the same basic operations on all of the item types. The operations in the context menu are related to the selected item.

Figure 3-16 shows a context menu for the stream item on the PSI/SI Management Tree.

![Figure 3-15: Stream Item Context Menu](image)
3.4.1. Exporting All DVB Network Information to XML

The Export command allows creating an XML-based file which includes the DVB network structure information. To export the DVB network information to XML:

1. From the network tree, right click the DVB icon.
2. Select Export to XML DTX file.
3. Choose a destination path for the file, and click OK.

3.4.2. Adding Items to the PSI/SI Management Tree

To add an item to the PSI/SI Management Tree, do the following:

1. Select an item from the PSI/SI Management Tree. The new item will be created beneath the selected item in a lower level. For example: to create a Service - select a stream that will contain the service.
2. Click the right mouse button on the item. A context menu is opened.
3. Choose the ‘New [Item Type]’ command from the context menu. A dialog is opened. Figure 3-16 shows a ‘New Service’ dialog example. The new item type is dependent on the selected item.
4. Enter the item ID in the dialog and click on the [OK] button. A new item was created.

Figure 3-16: New Service ID Dialog

**NOTE**

An ID number in any dialog can be written in decimal form or in hexadecimal form with a 0x prefix in the start of the hexadecimal number.
3.4.3. Changing Item ID on the PSI/SI Management Tree

To change an item ID number, do the following:
1. Select an item from the PSI/SI Management Tree.
2. Click the right mouse button on the item. A context menu is opened.
3. Choose the ‘Change [Item Type] ID’ command from the context menu. A dialog is opened. Figure 3-17 shows the ‘Change PID’ dialog example.
4. Change the item ID in the dialog and click on the [OK] button.
5. The item ID has changed.

![Change PID Dialog](image)

Figure 3-17: Change PID Dialog

3.4.4. Removing Items from the PSI/SI Management Tree

To remove an item from the PSI/SI Management Tree, do the following:
1. Select an item from the PSI/SI Management Tree.
2. Click the right mouse button on the item. A context menu is opened.
3. Choose the ‘Delete [Item Type]’ command from the context menu.
4. Confirm the item deletion.
5. The item has been deleted.
3.4.5. Copying / Cutting Items from the PSI/SI Management Tree

Items on the PSI/SI Management Tree can be moved and copied.

To Copy or Cut an item, do the following:
1. Select an item from the PSI/SI Management Tree.
2. Click the right mouse button on the item. A context menu is opened.
3. Choose the 'Copy' or the 'Cut' commands from the context menu.

3.4.6. Pasting Items on the PSI/SI Management Tree

To paste an item, do the following:
1. Select a target item from the PSI/SI Management Tree. The buffered item will be placed beneath the target item.
   The target item must be one level higher than the buffered item, providing that the target item is not the original parent of the buffered item.
   For example: a service can be copied only beneath a stream, which is not the current service parent.
2. Click the right mouse button on the item. A context menu is opened.
3. Choose the 'Paste' command. The buffered item appeared beneath the target item.

3.4.7. Drag and drop support

Moving an item to a different place in the PSI/SI Management Tree is done by dragging the item to a new place. Copying is done in the same manner with the CTRL key pressed. Dragging with the Shift key pressed opens a context menu. The context menu provides a selection between Moving, Copying and canceling the operation.
3.4.8. Disabling Items

Disabled item parameters will not be generated on the PSI/SI tables but will remain in the database. The item can be enabled again.

A disabled item is marked with Red icon as seen in Figure 3-18 on Service 0x1110, PID 0x1111 and stream 0x1300.

![Disabled Items in the PSI/SI Management Tree](image)

**Figure 3-18:** Disabled Items in the PSI/SI Management Tree

A disabled item makes its lower lever items automatically disabled too although the lower level items themselves are not marked as disabled.

For example: Service ID 0x1120 is disabled and so are his lower level items: PID 0x1121 and PID 0x1122. All the events inside this service are also disabled. The disabled items will not appear in the bit stream.

To enable / disable an item, do the following:
1. Select an item from the PSI/SI Management Tree.
2. Click the right mouse button on the item. A context menu is opened.
3. Choose the 'Enabled' command from the context menu.
4. The item state has been toggled between enabled and disabled.
3.4.9. Importing Events

The PSI/SI Generator has the ability to import events from external files in the following formats:

**Microsoft Excel Sheet** – an Excel file containing events information.

**EVT File** – an XML file containing events information with an EVT extension.

Example files for all import formats exist in the "Import" directory beneath the PSI/SI Generator installation directory.

To import events, do the following:

1. Select a service from the PSI/SI Management Tree.
2. Right click with the mouse on the selected service. A context menu appeared.
3. Select the commands: "Import from Excel File..." or "Import from XML EVT File..." from the context menu. A dialog is opened.
4. Select the appropriate data file from the dialog and click the [Open] button.

**NOTE**

*Importing from excel files format require the installation of excel version 9.0 (also known as Excel 2000) on the computer.*
3.5. DETAILED DISPLAY VIEW

The detailed display view shows the details of the selected item on the PSI/SI Management Tree. See Figure 3-19.

![Detailed Display View Diagram]

**Figure 3-19:** PSI/SI Generator PSI/SI Management Window

The 'Detailed Display' is divided into four sections:

a. **Item Name Section**
   - Shows the selected item on the PSI/SI Management Tree. Refer to paragraph 3.5.1.

b. **Properties Section**
   - Manages the properties of the tables and descriptors. Refer to paragraph 3.5.2.

c. **Descriptor List Section**
   - Manages the selected item descriptor list. Refer to paragraph 3.5.4.

d. **Descriptor Management Section**
   - Manages a selected descriptor from the list. Refer to paragraph 3.5.5.
NOTE

After changing any configuration, press the "Apply" button to accept the new configuration or "Refresh" to decline the new configuration and retrieve the one saved in the database. The new configuration will be lost unless the "Apply" button was pressed.

Sending data to the Multiplexer only occurs when choosing 'Send Tables' from the Data Carousel menu (refer to paragraph 3.2.1). Pressing the "Apply" button only saves the information on the database.

3.5.1. Item Name Section

The Item Name section displays the item name as it appears on the PSI/SI Management Tree. Refer to the item name section example on Figure 3-19. All the sections below the Item Name section are related to the Item itself.

The name of a Network item is determined by the "Network Name Descriptor". The name of a Service item is determined by the "Service Descriptor".

3.5.2. Properties Section

The properties section manages the selected item data. Each item type has a different properties section. Refer to the properties section example on Figure 3-19. The common controls in all the items are:

a. [Refresh] button – Restores the properties section parameters. Changes made by the user, which were not applied, will be lost.

b. [Apply] button – Applies the changes made by the user.

The following paragraphs describe the different properties sections for the streams, services and PIDs.
3.5.2.1. **Network Properties**

The network properties section manages the NIT table.

Figure 3-20 shows the Network properties section.

![Network Properties section](image1)

Figure 3-20: Network Properties section

3.5.2.2. **Stream Properties**

The stream properties section manages the PAT, CAT, NIT and SDT tables.

The NIT and SDT should usually be equal to the Network ID that contains them.

Figure 3-21 shows the stream properties section.

![Stream Properties section](image2)

Figure 3-21: Stream Properties section
3.5.2.3. Service Properties

The service properties section manages the PAT, PMT, SDT and EIT tables.

Figure 3-23 shows the service properties section.

![Service ID: 0x1130](image)

**Figure 3-22: Stream Properties section**

Configuring the PAT PMT PID and the PMT PCR PID correctly is crucial in establishing a correct transport stream. Refer to paragraph A.2 for coordinating these values with the multiplexer.

3.5.2.4. PID Properties

The PID properties section manages the PMT Stream Type.

Figure 3-23 shows the PID properties section.

![PID: 0x1131 (Video)](image)

**Figure 3-23: PID Properties section**

Changing the PMT stream type can be done by selecting a type from the list or directly edit the type number in the edit box next to the list.
3.5.3. Advanced Table Settings

Advanced Table Settings allow additional configuration of the table parameters, for example: configuring which sections the table is built and a manually selected table version. The highlighted section in Figure 3-24 shows the advanced management of the PAT table of a stream.

![Figure 3-24: Properties section – Advanced Management](image)

To display the advanced management section of a table, do the following:

1. Choose a table from the table tab.
2. Click the right mouse button on the table parameters area and choose from the pop up menu: **View Advanced Settings**. The advanced configuration for this table appears. See the following figure:

![Example of advanced settings](image)

3. The following parameters can be changed:

   By default, the [V] sign next to the ‘Create this PSI/SI table for this node’ is marked and the table is created. When the [V] sign is unmarked, the table will not be created.

   **To add a section number:**

   Check the 'Manually select table sections' parameter, enter a section number on the 'Enter section number' edit box from the right and click the [Add] button. The section number is inserted to the 'Section List' list box.
To delete a section number:
Select the section number from the section list and click the [Del] button.

To manually define a version for the table, mark [V] next to ‘Manually select version’ and write a version number on the edit box below.

NOTE

Always prefer the automatic selection of table sections.
The Table Generation Advanced management is for advanced users and for advanced purposes only!

3.5.4. Descriptors List Section

The descriptor list section manages the descriptor list for the selected item.

Figure 3-25 shows the descriptor list section.

![Figure 3-25: Descriptor List Section](image)

The Descriptors list section has the following buttons:

a. [Up] button – moves the selected descriptor one row above.
b. [Dn] button – moves the selected descriptor one row below.
c. [Tbl] button – switches between the PSI/SI tables. This button is enabled only when the selected descriptor can appear on a different table for the currently selected item.
d. **[Add]** button – opens a list of descriptors available to the current item. The selected descriptor will be added to the descriptor list. The descriptor dialog is organized in a hierarchy order by the descriptors tables. Figure 3-26 shows an example of the Select Descriptor dialog for a stream component.

![Select Descriptor Dialog](image)

**Figure 3-26: Select Descriptor Dialog**

b. **[Del]** button – delete a selected descriptor from the descriptor list.
3.5.5. Descriptors Management Section

The descriptor management section manages the descriptor parameters. Each descriptor has different parameters. Figure 3-27 shows the descriptor management section.

NOTE

- The Advanced Settings View is for advanced users and for advanced purposes only!
- After changing any configuration, press the "Apply" button to accept the new configuration or "Refresh" to decline the new configuration and return the old one. The new configuration will be lost unless the "Apply" button was pressed.
- Sending data to the Multiplexer only occurs when choosing 'Send Tables' from the Table menu (refer to paragraph 3.2.1). Pressing the "Apply" button only saves the information on the database.

Figure 3-27: Descriptor Management Section

Common controls for all the descriptors are:

[Refresh] button – Restore the descriptor parameters. Changes made by the user, which were not applied, will be lost.

[Apply] button – Apply the changes made by the user.

The Advanced Setting view (available by right clicking the descriptor) enables the user to fine tune where this descriptor will appear in the bit-stream (specific tables and/or specific sections). Under regular configurations, it is recommended to leave these settings untouched.
3.5.6. Proprietary Descriptors

The PSI/SI Generator features the ability to create proprietary descriptors. Proprietary descriptors are custom descriptors that contain user-defined data. Creating a proprietary descriptor is a flexible solution for special purpose descriptors. Each table in the ‘Select Descriptor’ dialog (refer to Figure 3-26) has, in addition to all the regular descriptors, a proprietary descriptor. Figure 3-28 shows the descriptor management section for the proprietary descriptor. The descriptor data length must be defined before setting the descriptor data.

![Proprietary Descriptors](image)

Figure 3-28: Proprietary Descriptors
Chapter 4. **Bouquets Management Window**

4.1. **General**

The bouquets management window manages all bouquets related parameters. Figure 4-1 shows the bouquet management window.

Figure 4-1: Bouquet Management Window
Each network has a different bouquet management window. To display a network bouquet management window, do the following steps:

1. Select the network from the PSI/SI Management Tree section in the PSI/SI Management window.
3. The bouquet management window for the selected network is opened.

The bouquet management menu bar and tool bar are identical to the PSI/SI Management window menu bar and tool bar. See paragraph 3.2 and paragraph 3.2.12.

The following sections explain the bouquet management window structure and commands.

4.2. Main Display View

Figure 4-1 shows the PSI/SI Generator bouquets management window.

The bouquets management window is divided into the following two sections:

a. Main Display – The Left side of the window showing the bouquets hierarchy.

b. Detailed Display – The right side of the window showing the details of the selected items on the bouquets hierarchy.

The main display view (See Figure 4-1) shows a tree with the bouquets of the selected network. Every bouquet includes one or more streams.

The operations that can be done on the items of the bouquet tree are identical to the operations that can be done on the PSI/SI Management Tree in the PSI/SI Management window. See paragraph 3.4 for detailed explanations on the available operations of the bouquet items in the bouquet tree.
4.3. **DETAILED DISPLAY VIEW**

Figure 4-1 shows the PSI/SI Generator bouquets management window.

The detailed display section of the PSI/SI Management window and the detailed display view (See Figure 4-1) of the bouquets management window are very similar. Only the differences between the two sections are described in the following paragraphs.

The Bouquet Management window ‘detailed display’ section can be found on paragraph 3.5.

The following paragraphs describe the detailed display view of the bouquets management window.

**NOTE**

After changing any configuration, press the “Apply” button to accept the new configuration or “Refresh” to decline the new configuration and return the old one. The new configuration will be lost unless the “Apply” button was pressed. Sending data to the Multiplexer only occurs when choosing ‘Send Tables’ from the Data Carousels menu (refer to paragraph 3.2.1). Pressing the “Apply” button only saves the information on the database.

4.3.1. **Item Name Section**

The item name section shows the selected item type and ID number. Refer to Figure 4-1. The name of a Bouquet item is determined by the “Bouquet Name Descriptor”.

4.3.2. **Properties Section**

The properties section in the bouquets management window enables to manage the BAT Table. Refer to Figure 4-1.

4.3.3. **Descriptors List Section**

The descriptor list section management is similar to the PSI/SI Management window descriptors list section. See paragraph 3.5.4.
4.3.4. Descriptor Management Section

The descriptor management section manages the selected descriptor parameters. Figure 4-1 shows the descriptor management section position in the bouquets management window. Each descriptor has different parameters.

Common controls for all the descriptors are:

a. [Refresh] button – Restore the descriptor parameters. Changes made by the user and were not applied will be restored.

b. [Apply] button – Apply the changes made by the user.

The Advanced Setting view (available by right clicking the descriptor) enables the user to fine tune where this descriptor will appear in the bit-stream (specific tables and/or specific sections). Under regular configurations, it is recommended to leave these settings untouched.

**NOTE**

The Advanced Settings View is for advanced users and for advanced purposes only.
Chapter 5.  
EVENT MANAGEMENT (EPG) WINDOW

5.1. GENERAL

The event management window manages all events related parameters, and is used to generate the EPG (Electronic Program Guide) data. Figure 5-3 shows the event management window.

Each service has a different event management window. To display a service event management window, do the following steps:

1. Select the service from the PSI/SI Management Tree section in the PSI/SI Management window.
2. Press the **Events** command in the ‘Additional’ Menu.
3. The events management window for the selected service is opened.

The following section explains the events management window.
5.2. **EVENT MANAGEMENT MENU BAR**

This section describes the Event Management Menu bar. Figure 5-1 displays the Menu Tree of the Event Management Window. Table 5-1 in paragraph 5.2.1 describes the structure of the menu bar and a brief description on each command. The following paragraphs explain some of the commands in more details.

![Figure 5-1: Event Management Window Menu Bar](image-url)

---

**Figure 5-1: Event Management Window Menu Bar**
5.2.1. Menu Structure

Table 5-1: Event Management Menu Bar

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database Sub Menu</strong></td>
<td>Same as the PSI/SI Management window Database Sub Menu. Refer to Table 3-1.</td>
</tr>
<tr>
<td><strong>Edit→Cut</strong></td>
<td>Cuts an event from the Main Display view. The Cut command is used for moving events to different places. The Paste command is used to paste the event in a different place on the calendar.</td>
</tr>
<tr>
<td><strong>Edit→Copy</strong></td>
<td>Copies an event from the Main Display view. The Copy command is used for copying events to different places. The Paste command is used to paste the event in a different place on the calendar.</td>
</tr>
<tr>
<td><strong>Edit→Paste</strong></td>
<td>Pastes an event under a selected place on the calendar.</td>
</tr>
<tr>
<td><strong>Edit→Move Range...</strong></td>
<td>Move all events between specified dates to a different date. The 'Move Groups of Events' dialog, shown below, provides controls for selecting a source date range and a destination date.</td>
</tr>
</tbody>
</table>

![Move Group of Events](image)

Move all events in the range:

- **From**: 01/01/2000 12:00:00 AM
- **To**: 27/08/2003 12:00:00 AM

To the range which starts at:

- **From**: 01/01/2003 12:00:00 AM

[OK] [Cancel]
Table 5-1: Event Management Menu Bar

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit→Delete Range...</td>
<td>Deletes all events within a selected range. The ‘Select Date Range’ dialog, shown below, provides controls for selecting a date range.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Delete Group of Events" /></td>
</tr>
<tr>
<td>Data Carousels Sub Menu</td>
<td>Same as the PSI/SI Management window Data Carousel Sub Menu. Refer to Table 3-1.</td>
</tr>
<tr>
<td>Tools Sub Menu</td>
<td>Same as the PSI/SI Management window Tools Sub Menu. Refer to Table 3-1.</td>
</tr>
<tr>
<td>GoTo→Today</td>
<td>Changes the calendar date to the current day.</td>
</tr>
<tr>
<td>GoTo→Date...</td>
<td>Opens the select date dialog. The calendar date will change to the date that was selected in the dialog.</td>
</tr>
<tr>
<td>GoTo→Previous...</td>
<td>Moves the calendar to the previous screen.</td>
</tr>
<tr>
<td>GoTo→Next...</td>
<td>Moves the calendar to the next screen.</td>
</tr>
<tr>
<td>GoTo→Event→Present</td>
<td>Find the event at the current date and time.</td>
</tr>
<tr>
<td>GoTo→Event→First</td>
<td>Find the first event on the calendar.</td>
</tr>
<tr>
<td>GoTo→Event→Previous</td>
<td>Find the previous event from the current date.</td>
</tr>
<tr>
<td>GoTo→Event→Next</td>
<td>Find the next event from the current date.</td>
</tr>
</tbody>
</table>
### Table 5-1: Event Management Menu Bar

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoTo → Event → Last</td>
<td>Find the last event on the calendar.</td>
</tr>
<tr>
<td>GoTo → Event → Find…</td>
<td>Opens the Find Event dialog. Refer to 5.2.2.</td>
</tr>
<tr>
<td>Goto → Event → Focus on Selected</td>
<td>Focuses the view on the selected event.</td>
</tr>
<tr>
<td>View → One Day</td>
<td>The calendar displays one day at a time</td>
</tr>
</tbody>
</table>
### Table 5-1: Event Management Menu Bar

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View ➔ Work Week</strong></td>
<td>The calendar displays five days at a time</td>
</tr>
<tr>
<td><img src="connected_to_d_program_file_scopuspsi_generator_event_gd" alt="Image of work week view" /></td>
<td></td>
</tr>
<tr>
<td><strong>View ➔ Week</strong></td>
<td>The calendar displays a whole week at a time</td>
</tr>
<tr>
<td><img src="connected_to_d_program_file_scopuspsi_generator_event_gd" alt="Image of week view" /></td>
<td></td>
</tr>
</tbody>
</table>
Table 5-1: Event Management Menu Bar

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>View→Month</td>
<td>The calendar displays a whole month at a time.</td>
</tr>
</tbody>
</table>

![Calendar Displaying a Whole Month](image_url)
5.2.2. Finding Events

The Find Events dialog searches the calendar for a specific event. The events can be found by their ID number or by their name property.

The Find Events dialog is opened by choosing GoTo ➔ Events ➔ Find... on the menu bar of the Event Management screen.

Figure 5-2 shows the two tabs of the Find Event dialog.

[A] : Find by ID Tab                                                      [ B ] : Find by Name Tab

![Find Event Dialog]

Figure 5-2: Find Event Dialog

To find an event by its ID number, type in the ID edit box on Figure 5-2 [A] the specific event ID and press the [Find] button.

To find an event by its name, type in the big edit box on Figure 5-2 [B] a text that the name contains and press one of the following buttons:

a. [First] button – finds the first occurrence of an event that matches the text.

b. [Previous] button – Finds the previous occurrence of an event that matches the text.

c. [Next] button - Finds the next occurrence of an event that matches the text.

d. [Last] button - Finds the last occurrence of an event that matches the text.

The Event name is the text defined in the "Short event descriptor" under this event.
5.3. **TOOL BAR**

The Event Management tool bar is mostly identical to the PSI/SI Management window tool bar. Refer to the PSI/SI Management window tool bar in paragraph 3.2.12. In addition, the Event Management tool bar includes the commands from the Go To menu and View menu. Refer to Table 5-1: Event Management Menu Bar.

5.4. **MAIN DISPLAY VIEW**

Figure 5-3 shows the PSI/SI Generator event management window.

![Event Management Main Display View](image)

**Figure 5-3: Event Management Main Display View**

The event management window is divided into two sections:

- **Main Display**, on the left side of the window, showing a calendar.
- **Detailed Display**, on the right side of the window, showing the details of the selected event on the calendar.

The calendar in the main display screen has several display modes; One-day display, Five days display, Week display and Month display. See section 5.2 for more details on the different calendar displays.
An event is shown inside blue frames with its Event ID number and its name. Clicking with the right mouse button on the calendar displays a context menu. The operations in the context menu are related to the selected event. The following paragraphs describe the context menu commands.

5.4.1. Creating Events

Create an event by doing one of the following:
1. Select New Event from the context menu.
2. Double click on the calendar.
3. Drag the mouse from the starting hour to the ending hour in the one day display.

A ‘New Event’ dialog is opened (See Figure 5-4). The application suggests a new unique ID number to the event. The user might want to change the event ID by editing the ID number in the edit box. Pressing the [OK] button will create a new event.

![New Event ID Dialog](image)

Figure 5-4: New Event ID Dialog

5.4.2. Changing Events ID

Change an event by following the steps below:
1. Select an event from the calendar.
2. Choose the Change Event ID command from the context menu.
   A dialog which resemble to Figure 5-4 is opened.
3. Change the ID number on the dialog
4. Press the [OK] button.
5.4.3. Removing Events

To remove an item from the calendar follows the instructions below:
1. Select an event
2. Choose the **Delete Event** command from the context menu or press the Del key on the keyboard.
3. A confirmation is required to delete the event. Press the [**Yes**] button on the confirmation dialog.
4. The event has been deleted.

5.4.4. Copying / Cutting / Pasting Events

Events on the calendar can be moved and copied.

To Copy or Cut an event, do the following:
1. Select an event from the calendar
2. Click the right mouse button on the event. A context menu is opened.
3. Choose the ‘**Copy**’ or the ‘**Cut**’ commands from the context menu.

To paste the event in a different place, do the following:
1. Select a place on the calendar to copy or move the buffered event.
2. Click the right mouse button on the selected place. A context menu is opened.

5.4.5. Drag and drop support

Moving an event to a different place in the calendar can be done by dragging the event to the new place. Coping can be done in the same manner with the CTRL key pressed. Dragging with the Shift key pressed will open a context menu providing a selection between Moving, Copying and canceling the operation.

5.4.6. Disabling Events

Disabled event parameters will not be generated on the PSI/SI tables but will remain in the database. The event can be enabled again.
A disabled event is marked with a red icon as seen in Figure 5-5 on Event 0x0007.

![Disabled Event in the Calendar](image)

**Figure 5-5: Disabled Event in the Calendar**

To disable an event, do the following:
1. Select an event from the calendar.
2. Click the right mouse button on the event. A context menu is opened.
3. Choose the 'Enabled' command from the context menu.
4. The event state has been toggled between enabled and disabled.

### 5.4.7. Changing Time Resolution

The time resolution of the calendar is adjustable. The time resolution represents how much time each raw in the calendar stand for. The options are: 5min, 6min, 10min, 15min, 30 min and 60min.

To change the time resolution, do the following:
1. Right click with the mouse on the time scale on the left side of the calendar.
   A context menu is opened.
2. Select from the context menu the required time resolution.
5.5. **DETAILED DISPLAY VIEW**

Figure 5-6 shows the PSI/SI Generator event management window.

The event management window is divided into the following two sections:

- **Main Display** – The left side of the window showing a calendar.
- **Detailed Display** – The right side of the window showing the details of the selected event on the calendar.

![Detailed Display View Diagram](image)

**Figure 5-6: Event Management Detailed Display View**

The following paragraphs describe the detailed display view of the event management window.

The PSI/SI Management window also has a detailed display section. The detailed display section of the PSI/SI Management window and the detailed display section of the events management window are very similar. Only the differences between the two sections are described in the following paragraphs.
NOTE

After changing any configuration, press the "Apply" button to accept the new configuration or "Refresh" to decline the new configuration and return the old one. The new configuration will be lost unless the "Apply" button was pressed. Sending data to the Multiplexer only occurs when choosing "Send Tables" from the Table menu (refer to paragraph 3.2.1). Pressing the "Apply" button only saves the information locally.

5.5.1. Item Name Section

The item Name section shows the selected event ID number and name. See Figure 5-6. The name of an Event item is determined by the "Short Event Descriptor". The color of an event item is determined by the "Content Descriptor".

5.5.2. Properties Section

The properties section shows the event date, time and duration. Figure 5-6 shows the properties section position in the event management window. Figure 5-7 shows an example of the Properties section. Table 5-2 explains the properties section.

![Figure 5-7: Data Section Example](image)

Table 5-2: Data Section Parameters

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time - Date</td>
<td>Manages the starting date of the selected event</td>
</tr>
<tr>
<td>Start Time - Hour</td>
<td>Manages the starting time of the selected event</td>
</tr>
<tr>
<td>End Time - Date</td>
<td>Manages the ending date of the selected event</td>
</tr>
<tr>
<td>End Time - Hour</td>
<td>Manages the ending time of the selected event</td>
</tr>
</tbody>
</table>
### Table 5-2: \(\text{Data Section Parameters}\)

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>(\text{Duration - Hr})</td>
<td>Manages the event duration in hour units</td>
</tr>
<tr>
<td>(\text{Duration - Min})</td>
<td>Manages the event duration in minute units</td>
</tr>
<tr>
<td>(\text{Duration - Sec})</td>
<td>Manages the event duration in second units</td>
</tr>
<tr>
<td>(\text{Free CA Mode})</td>
<td>Turns on and off the Free CA Mode</td>
</tr>
<tr>
<td>(\text{Apply})</td>
<td>Saves the changes made to the data section</td>
</tr>
<tr>
<td>(\text{Refresh})</td>
<td>Restore the data section parameters. Changes made by the user and were not applied will be restored.</td>
</tr>
</tbody>
</table>

### 5.5.3. Descriptors List Section

The description list section management is similar to the descriptors list section in the PSI/SI Management window. See paragraph 3.5.4.

### 5.5.4. Descriptor Management Section

The descriptor management section manages the selected descriptor parameters. Figure 5-6 shows the descriptor management section position in the event management window. Each descriptor has different parameters.

Common controls for all the descriptors are:

- \(\text{[Refresh]}\) button – Restore the descriptor parameters. Changes made by the user and were not applied will be restored.
- \(\text{[Apply]}\) button – Apply the changes made by the user.

The Advanced Setting view (available by right clicking the descriptor) enables the user to fine tune where this descriptor will appear in the bit-stream (specific tables and/or specific sections). Under regular configurations, it is recommended to leave these settings untouched.

**NOTE**

*The Advanced Settings View is for advanced users and for advanced purposes only.*
Chapter 6.
SCHEDULER MANAGEMENT

6.1. GENERAL

The PSI/SI Generator features a task Scheduler. The scheduler performs pre-defined tasks according to their timing scheme.

This chapter explains the three components that need to be defined to schedule a task:

- Defining the task timing scheme
- Defining the task commands
- Defining the Data Carousels to be updated

6.2. SCHEDULER DIALOG

The Scheduler dialog can be opened from the menu bar: Tools→Scheduler or from the tool bar. Refer to paragraph 3.2.12 for the Scheduler icon display on the tool bar.

Figure 6-1: Scheduler Dialog
The Scheduler dialog contains the following components:

a. **Task list** – a list of all the tasks that have been set to the scheduler

b. **Task parameters** – defines the task commands, timing scheme and Data Carousels to be used. Paragraph 6.3 explains how to set up a task.

c. **[New]** button – add a new task to the task list

d. **[Delete]** button – deletes a task from the task list

e. **[Apply]** button – saves the changes made to the task parameters

f. **[Refresh]** button – restores changes that were not applied.

g. **[Close]** button – closes the Scheduler dialog.

### 6.3. Task Parameters

The task parameters are composed out of the three following tabs:

#### 6.3.1. General Tab

The general tab defines the task name and the Data Carousels that sends the updated tables. The tables are updated automatically by the task, when it performs at the scheduled time (See Figure 6-1 for the general tab location).

The General Tab contains the following components:

a. **Scheduling Task Name**
   Changes the task name

b. **Data Carousel list**
   List of Data Carousels that sends the new tables from the specified profiles after the task performs. Note that for each data carousel, a different profile may be selected.

c. **Data Carousel Name Selection**
   Select or write the Data Carousel name that will be added to the list.

d. **[Add]** button – Adds the Data Carousel to the Data Carousels list.

e. **[Del]** button – Deletes the selected Data Carousel out of the Data Carousels list.

f. **When Sending Tables** – decide whether all the tables are refreshed or only updated tables are refreshed after the execution of the commands.
The General Tab has the following operations:

a. **Changing the task name:**
   Rewrite the task name in the Scheduling Task Name

b. **Adding a Data Carousel:**
   1. Select or write the Data Carousel name in the ‘Data Carousel Name Selection’ combo box.
   2. Press the [Add] button.

c. **Deleting a Data Carousel:**
   1. Select a Data Carousel from the Data Carousels list.
   2. Press the [Delete] button.

### 6.3.2. Commands Tab

A task is composed of several commands. The Commands tab defines the set of commands to be executed. The commands are displayed in the commands list. The commands are executed one by one from the top of the list to the bottom. The commands are executed at the time defined by the Timing Tab. Figure 6-2 shows the Commands tab.

![Scheduler Dialog – Commands Tab](image)

**Figure 6-2: Scheduler Dialog – Commands Tab**
The following commands are available:

- Enable ID Command – For details see section 6.3.2.1.
- Change ID Command – For details see section 6.3.2.2.
- Send TCP Message Command – For details see section 6.3.2.3.
- Run External File – For details see section 6.3.2.4.
- Backup Database Command – For details see section 6.3.2.5.
- Clear Log Command – For details see section 6.3.2.6.
- Delete Old Events Command – For details see section 6.3.2.7.
- Delete All Events Command – For details see section 6.3.2.8.
- Export Data Command – For details see section 0.
- Import Data Command – For details see section 6.3.2.10.
- Exporting Log Command – For details see section 6.3.2.11.
- Change PCR PID Command - For details see section 6.3.2.12.

The Commands tab contains the following components:

a. **Commands List** Defines the commands included in the task.

b. **Command Parameters** Define the command parameters. The Command Parameters displays the parameters of the selected command in the Commands List.

c. **[Up] button** – Move the selected command higher in the execution order.

d. **[Dn] button** – Move the selected command lower in the execution order.

e. **[Add] button** – Adds a command to the Commands List. A selection box with the command types appear after pressing the button. The selected command type is added to the bottom of the Command List.

f. **[Del] button** – Deletes the selected command from the Commands List.

**NOTE**

Should one of the commands fail when the task executes, the rest of the commands in the task are canceled (Except the ‘Send TCP Message’ command and ‘Run External File’ command).
6.3.2.1. Enable ID Command

The Enable ID command is used for enabling or disabling a node in the DVB PSI/SI Management Tree. Figure 6-3 shows the Enable ID command parameters.

Figure 6-3: Scheduler Dialog – Enable ID Command Parameters

The Enable ID command contains the following parameters:

a. **Profile** - Defines on which profile exists the specified node.

b. **Node Type** - Defines on which DVB item type should the command be executed. Available types are:
   - Network
   - Network – Stream
   - Network – Stream – Service
   - Network – Stream – Service – PID
   - Network – Stream – Service – Event
   - Network – Bouquet
   - Network – Bouquet – Stream

c. **Node ID**

   Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors. The exact ID number of the selected node and its ancestors should be defined. To change an ID value of a node in the table, do the following:
   1. Double click the ID number next to the selected node.
   2. Enter the node value.

d. **Make this node**

   This parameter defines the status of the node after execution. The status can be Enabled or Disabled.
6.3.2.2. Change ID Command

The Change ID command is used for altering an ID of an item from the DVB PSI/SI Management Tree. Figure 6-2 shows the Change ID command parameters.

The Enable ID command contains the following parameters:

a. **Profile** – Defines on which profile exists the specified node.

b. **Node Type** – Defines on which DVB item type should the command be executed. Available types are:
   - Network
   - Network – Stream
   - Network – Stream – Service
   - Network – Stream – Service – PID
   - Network – Stream – Service – Event
   - Network – Bouquet
   - Network – Bouquet – Stream

c. **Node ID** – Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors. The exact ID number of the selected node and its ancestors should be defined.

   To Change an ID value of a node in the table, do the following:
   1. Double click the ID number next to the selected node.
   2. Enter the node value.

d. **Change [Node Type] ID to** – This parameter defines an alternative value for the above selected node. The [Node Type] above is the type of the selected node.
6.3.2.3. Send TCP Message Command

The Send TCP Command is used for sending a message through TCP at a scheduled time. Figure 6-4 shows the Send TCP Message command parameters.

![Scheduler Dialog – Send TCP Message Command Parameters](image)

**Figure 6-4: Scheduler Dialog – Send TCP Message Command Parameters**

The Send TCP Message command contains the following parameters:

a. **Address:**
   1. **Host name or IP** – The message is sent to the host name or IP address.
   2. **Port** – The message is sent on a specific port number.

b. **Take message content from** – The Message tab is edited according to these parameter settings:
   - **Byte Array** – the message content is an array of bytes.
   - **Text String** – the message content is a text string.
   - **File** – the message content is a file.

c. **Message tab** – Used for editing the message contents:
   - **Byte Array** – specify the array size and edit the array table.
   - **Text String** – write a text string
   - **File** – specify the full path name of the file. The file is on the server computer.
6.3.2.4. **Run External File Command**

The Run External File command is used for running a file on the server computer at a scheduled time. Figure 6-5 shows the Run External File Command parameters.

![Scheduler Dialog – Run External File Command Parameters](image)

**Figure 6-5:** Scheduler Dialog – Run External File Command Parameters

The Run External File command contains the following parameters:

a. **File Name** – The full path name of the executable file must be included. The file is in the server computer.

b. **Parameters** – Optionally add parameters to the executable file.

**NOTE**

*The executable file will be running in the system security context.*
6.3.2.5. Backup Database Command

The Backup Database command is used for creating a backup file (GBK) at a scheduled time. Figure 6-6 shows the Backup Database Command parameters.

![Backup Database Command Parameters](image)

**Figure 6-6: Scheduler Dialog – Backup Database Command Parameters**

The Backup Database command contains the following parameters:

**a. Backup Filename** – The full path name of the file must be included. The file is saved on the server computer.

**b. Logon as User** – Enabling password protection when for the database backup task.

**NOTE**

*The username and password must be identical to the computer's main username and password.*
6.3.2.6. Clear Log Command

The Clear Log command is used for removing all information from the log file. Figure 6-7 shows the Clear Log Command parameters.

![Scheduler Dialog – Clear Log Command Parameters](image)

**Figure 6-7: Scheduler Dialog – Clear Log Command Parameters**

The Clear Log command contains the following parameters:

- **Save Log to File Before Clearing** – all existing information is stored under the `../Logs` folder before clearing the log file.
6.3.2.7. **Delete Old Events Command**

The Delete Old Events command is used for removing all events occurred prior to the scheduled time. Figure 6-15 shows the Delete Old Events Command parameters.

![Delete Old Events Command Parameters](image)

**Figure 6-8: Scheduler Dialog – Delete Old Events Command Parameters**

The Delete Old Events command contains the following parameters:

**a. Profile** - Defines on which profile exists the specified node.

  **b. Node Type** – Defines on which DVB item type should the command be executed. Available type Network – Stream – Service

**c. Node ID**

Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors. The exact ID number of the selected node and its ancestors should be defined.

To Change an ID value of a node in the table, do the following:

1. Double click the ID number next to the selected node.
2. Enter the node value.

**d. Delete Events Older then**

This parameter defines which events are considered old, by setting the Days and Hours parameters.
6.3.2.8. Delete All Events Command

The Delete All Events command is used for removing all of the events from the database. Figure 6-15 shows the Delete All Events Command parameters.

![Figure 6-9: Scheduler Dialog – Delete All Events Command Parameters](image)

The Delete All Events command contains the following parameters:

a. **Profile** - Defines on which profile exists the specified node.

b. **Node Type** - Defines on which DVB item type should the command be executed. Available type is Network – Stream – Service.

c. **Node ID**

   Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors.

   The exact ID number of the selected node and its ancestors should be defined. To Change an ID value of a node in the table, double click the ID number next to the selected node and then enter the node value.
6.3.2.9. **Export Data Command**

The Export Data command is used for creating an Excel or XML format of the event's data. Figure 6-15 shows the Export Data Command parameters.

![Scheduler Dialog – Export Data Command Parameters](image)

Figure 6-10: Scheduler Dialog – Export Data Command Parameters

The Export Data command contains the following parameters:

a. **Profile** - Defines on which profile exists the specified node.

b. **Node Type** – Defines on which DVB item type should the command be executed. Available types are; Network, Stream, Service

c. **Node ID** - Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors.

The exact ID number of the selected node and its ancestors should be defined. To Change an ID value of a node in the table, double click the ID number next to the selected node and then enter the node value.

d. **Exporter** - Defines the export file format. The current software version supports XML only.

e. **File Name** - Defines a name for the exported file.

f. **Logon as User** – Enabling password protection to the task.

**NOTE**

The username and password must be identical to the computer's main username and password.
6.3.2.10. **Import Data Command**

The Import Data command is used for loading Excel or XML events file.

Figure 6-15 shows the Import Data Command parameters.

![Scheduler Dialog – Import Data Command Parameters](image)

The Import Data command contains the following parameters:

a. **Profile** - Defines on which profile exists the specified node.

b. **Node Type** – Use the Network – Stream – Service node type.

c. **Node ID** - Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors.

   The exact ID number of the selected node and its ancestors should be defined. To Change an ID value of a node in the table, double click the ID number next to the selected node and then enter the node value.

c. **Importer** - Defines the import file format, the current software version supports Excel and XML formats. Refer to 3.4.9 for more details.

d. **File Name** - Defines a name for the imported file.

e. **Logon as User** – Enabling login for accessing the import file when required.
6.3.2.11. Exporting Log Command

The Export Data command is used for creating a log file in HTML format. The file is located under the following path:

`..\scopus\psi-si generator\log\data_hour.html`.

Figure 6-15 shows the Exporting Log Command parameters.

![Scheduler Dialog – Exporting Log Command Parameters](image)

Figure 6-12: Scheduler Dialog – Exporting Log Command Parameters

The Exporting Log command contains the following parameters:

a. **Backup Filename** – The full path name of the file must be included. The file is saved on the server computer.

b. **Overwrite Previous File** – When unchecked, each export is saved to a new file.
6.3.2.12. Change PCR PID Command

The Change PCR PID command is used for setting a new value for the PCR PID.

Figure 6-15 shows the Change PCR PID Command parameters.

![Scheduler Dialog – Change PCR PID Command Parameters](image)

Figure 6-13: Scheduler Dialog – Change PCR PID Command Parameters

The Change PCR PID command contains the following parameters:

a. Profile - Defines on which profile exists the specified node.

b. Node Type - Defines on which DVB item type should the command be executed. Available type is: Network - Stream - Service

c. Node ID

Defines on which node the command should be executed. The Node ID displays a table with the selected node type and all of its ancestors. The exact ID number of the selected node and its ancestors should be defined.

To Change an ID value of a node in the table, do the following:

1. Double click the ID number next to the selected node.
2. Enter the node value.

d. PCR PID - Defines the new PID value for the PCR.

This parameter defines which events are considered old, by setting the Days and Hours parameters.
6.3.3. Timing Tab

The Timing tab is used to define the time of task execution. The Timing tab features a sophisticated and flexible task scheduling.

The Timing tab has four recurrence patterns:

a. **Never** – The task never executes.
b. **Once** – The task executes once in a specific time.
c. **Daily** – The task executes on a daily basis.
d. **Weekly** – The task executes on a weekly basis.
e. **Monthly** – The task executes on a monthly basis.

Paragraphs 6.3.3.1 - 6.3.3.5 explains the five recurrence patterns.

6.3.3.1. Never

The ‘Never’ recurrence pattern option is used to keep a task in the task list but to postpone the task to an unknown date. Figure 6-14 shows the ‘Never’ option in the scheduler dialog.

![Scheduler Dialog – Timing Tab - Never](image)

Figure 6-14: Scheduler Dialog – Timing Tab - Never
6.3.3.2. Once

The ‘Once’ recurrence pattern option is used for performing a task one specific time.

![Scheduler Dialog – Timing Tab - Once]

When the ‘Once’ recurrence patterns is selected, a Date/Time edit box appears next to it. The Date/Time edit box is used for defining the execution time and date.
6.3.3.3. Daily

The Daily recurrence pattern option is used to execute a task every day, or every several days. Figure 6-16 shows the Daily option in the scheduler dialog.

![Scheduler Dialog – Timing Tab - Daily](image)

The ‘Daily’ recurrence pattern option has the following setting:

a. **Every X Day(s)** – the task occur every number of days. The number of days defined in the Day Count Edit box. When Day Count is one, the task will occur every day.

b. **Start at** – The date and time of the first execution of the task. The time of the first execution will be the time of all other executions.

c. **Ending date** – the ending date can be set to three options:
   - **Never end** – the task continue executing at the appropriate time.
   - **End after X occurrences** – The task will be executed a constant number of times and then stop. The number of times is defined in the ‘number of time to run’ edit box.
   - **End by date** – the task stops executing after a specified date and time. The date and time are defined in the ‘End by’ Date/Time edit box.
6.3.3.4. Weekly

The 'Weekly' recurrence pattern option is used for executing a task on a specific day or days in the week.

The 'Weekly' recurrence pattern option has the following setting:

a. **Every X Week(s)** – the task will occur every number of weeks. The number of weeks is defined in the Week Count edit box. When Week Count is one, the task will occur every Week, on the specified days.

b. **Weekdays** – the task occurs only on checked days in the weekdays table.

c. **Start at** – The date and time of the first execution of the task. The time of the first execution will be the time of all other executions.

d. **Ending date** – the ending date can be set to three options:
   - **Never end** – the task continue executing at the appropriate time.
   - **End after X occurrences** – The task will be executed a constant number of times and then stop. The number of times is defined in the ‘number of time to run’ edit box.
   - **End by date** – the task stops executing after a specified date and time. The date and time are defined in the ‘End by’ Date/Time edit box.
6.3.3.5. Monthly

The ‘Monthly’ recurrence pattern option is used for executing a task on a specific day or days in a month.

Figure 6-18: Scheduler Dialog – Timing Tab - Monthly

The ‘monthly’ recurrence pattern option has the following settings:

a. **Every X Month(s)** – the task will occur every number of months. The number of months is defined in the Month Count edit box. When Month Count is one, the task will occur every Month, on the specified days.

b. **Month Days** – the task occurs only on checked days in the month day table.

c. **Start at** – The date of the first execution of the task.

d. **Time of Occurrence** - The time of each execution.

e. **Ending date** – the ending date can be set to three options:
   - **Never end** – the task continue executing at the appropriate time.
   - **End after X occurrences** – The task will be executed a constant number of times and then stop. The number of times is defined in the ‘number of time to run’ edit box.
   - **End by date** – the task stops executing after a specified date and time. The date and time are defined in the ‘End by’ Date/Time edit box.
Appendix A
RTM 3300/3800 CONFIGURATION

To configure the PSI/SI Generator correctly, several items need to be checked on the Multiplexer. Paragraph A.1 describes the checking process of the tables’ status. Paragraph A.2 describes the checking process of the PID numbers. All operations on those paragraphs are performed on the Multiplexer terminal.

The following paragraphs describe procedures on the CODICO® RTM-3300/3800 DVB Multiplexer. If another Multiplexer is used, please refer to the specific Multiplexer user manual.

A.1 CHECKING TABLES STATUS

To retrieve the table status information, on the Multiplexer main menu press ‘c’ (configuration menu) and then ‘t’ (Automatic Tables configuration menu).

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto. PAT</td>
<td>ena/dis [DISABLED], toggle</td>
</tr>
<tr>
<td>Auto. PMT</td>
<td>ena/dis [DISABLED], toggle</td>
</tr>
<tr>
<td>Auto. NIT</td>
<td>ena/dis [DISABLED], toggle</td>
</tr>
<tr>
<td>Auto. SDT</td>
<td>ena/dis [DISABLED], toggle</td>
</tr>
<tr>
<td>Auto. TDT</td>
<td>ena/dis [ENABLED], toggle</td>
</tr>
</tbody>
</table>

Figure A-1: Auto Table Configuration on the Multiplexer Terminal

The terminal shows the status of the table types generated by the Multiplexer (refer to figure A-1). All enabled table types are generated by the Multiplexer.

To toggle a table state between enabled and disabled:
1. Press the number of the table on the keyboard.
2. When asked if you want to toggle the status, click ‘y’.
3. The status of the table has changed.

CAUTION

Tables can be created by the Multiplexer or with the PSI/SI Generator. Every option has its advantages.

It is important to check that no tables will be generated twice! Refer to Paragraph 3.2.12 for configuring table generation on the PSI/SI Generator.
NOTE

The Multiplexer clock and the PSI/SI Generator clock must be synchronized once upon installing the program. The time should be entered as GMT time on the Multiplexer. It is recommended that the TDT table be generated by the Multiplexer.

A.2 CHECKING PID AND SERVICE NUMBERS

Follow the instruction below to retrieve the PID and Service numbers:
1. On the Multiplexer main menu press ‘m’ (“Multiplexer transport information”).
2. Press ‘m’ again. (“Multiplexer transp. Stat (‘m’ or ‘n’ or ‘i’)”).

Figure A-2 shows an example of the Multiplexer terminal screen.

Figure A-2: Screen Shot of PID List on the Multiplexer Terminal
The terminal shows the PID numbers and their categories for every service and wait until a key is pressed to show the next service.

Update the PID numbers on the Hierarchy Tree on the PSI/SI Generator in order to keep them synchronized. That way, the tables generated by the PSI/SI Generator will match the contents of the Multiplexer.

**NOTES**

- Generally, changing PID numbers should be performed on both the Multiplexer and the PSI/SI Generator.
- On advanced applications, the PID numbers on the Multiplexer and the PSI/SI Generator may be different.

Configure the Mux to Support ASI Interface

### A.3 CONFIGURE THE MUX TO SUPPORT ASI INTERFACE

To configure the Mux to support ASI, Enter the following lines to the “MCMUX.RMP” file while **XX** is the Mux input number (0-18):

- InputTransparent **XX**
- RemapInPid **XX** 0x1FFE 0

**NOTES**

- Refer to the RTM3300/3800 manual, chapter 6 for detailed instruction about editing the MCMUX.RPM.
- The number 0x1FFE on the RemapInPid line below should be identical to the stuffing packet PID defined in the PSI/SI Generator. Refer to paragraph 3.2.12 for more details about ASI configuration and the stuffing packet PID.
A.4 CONFIGURE THE MUX TO SUPPORT UDP INTERFACE

To configure the Mux to support UDP, Enter the following lines to the “MCMUX.CFG” file while N is the UDP Host Port:
do the following:

- CtrlUdp0Ena ENABLE
- CtrlUdp0HostPort N

When using multicast, change the following line while XXX.XXX.XXX.XXX is the multicast IP address:

- CtrlUdp0HostIP XXX.XXX.XXX.XXX

**NOTE**

- Refer to the RTM3300/3800 manual, chapter 6 for detailed instruction about editing the MCMUX.CFG.
- Although the Mux port number can be any number, it is advised to use port 8000.
- The IP address defined in the PSI/SI Generator should be identical to the Mux IP address or to the multicast IP address defined in the “MCMUX.CFG” file. The port number defined in the PSI/SI Generator should be identical to the port number defined in the “MCMUX.CFG” file.